
Chapter 18

Geomorphometry in RiverTools

Peckham S.D.1

history and development of RiverTools •2

preparing a DEM for your study area •3

kinds of information that can be4

extracted using RiverTools and DEMs •5

special visualisation tools in RiverTools •6

what makes the RiverTools software7

unique?8

18.1 Getting started9

RiverTools is a software toolkit with a user-10

friendly, point-and-click interface that was11

specifically designed for working with DEMs and12

extracting hydrologic information from them. As13

explained in previous chapters, there is a lot of14

useful information that can be extracted from15

DEMs since topography exerts a major control16

on hydrologic fluxes, visibility, solar irradiation,17

biological communities, accessibility and many18

human activities. RiverTools has been commer-19

cially available since 1998, is well-tested and has20

been continually improved over the years in re-21

sponse to the release of new elevation data sets22

and algorithms and ongoing feedback from a23

global community of users. All algorithms bal-24

ance work between available RAM and efficient25

I/O to files to ensure good performance even26

on very large DEMs (i.e. 400 million pixels or27

more). RiverTools is a product of Rivix, LLC28

(www.rivix.com) and is available for Windows,29

Mac OS X and Solaris.30

RiverTools 3.0 comes with an installation CD31

and sample data CD but the installer can also32

be downloaded from www.rivertools.com. It33

uses the industry-standard InstallShield installer 34

and is therefore easy to install or uninstall. 35

The HTML-based help system and user’s guide 36

includes a set of illustrated tutorials, a glos- 37

sary, step-by-step explanations of how to per- 38

form many common tasks, a description of each 39

dialog and a set of executive summaries for major 40

DEM data sets and formats. All of the RiverTools 41

file formats are nonproprietary and are explained 42

in detail in an appendix to the user’s guide. In 43

addition, each dialog has a Help button at the 44

bottom that jumps directly to the relevant sec- 45

tion of the user’s guide. 46

The purpose of this chapter is to provide an 47

overview of what RiverTools can do and how it 48

can be used to rapidly perform a variety of tasks 49

with elevation data. §18.1.1 explains the layout 50

of the RiverTools menus and dialogs. §18.2 briefly 51

discusses GIS issues such as ellipsoids and map 52

projections. §18.3 introduces some tools in the 53

Prepare menu that simplify the task of preparing 54

a DEM that spans a given area of interest. §18.4 55

discusses how dialogs in the Extract menu can 56

be used to extract various grid layers and masks 57

from a DEM. §18.5 highlights some of the visu- 58

alisation tools in the Display menu and §18.5.1 59

introduces some of the Interactive Window Tools 60

that can be used to query and interact with an 61

image. 62

18.1.1 The RiverTools menu and dialogs 63

RiverTools 3.0 can be started by double-clicking 64

on a shortcut icon or by selecting it from a list 65

of programs in the Windows Start menu. After 66

a startup image is displayed, the Main Window 67

appears with a set of pull-down menus across the 68

top labeled: File, Prepare, Extract, Display, An- 69
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alyze, Window, User and Help. Each pull-down1

menu contains numerous entries, and sometimes2

cascading menus with additional entries. Select-3

ing one of these entries usually opens a point-4

and-click dialog that can be used to change var-5

ious settings for the selected task. Buttons la-6

beled Start, Help and Close are located at the7

bottom of most dialogs. Clicking on the Start8

button begins the task with the current settings.9

Clicking on the Help button opens a browser win-10

dow to a context-specific help page and clicking11

on a Close or Cancel button dismisses the dialog.12

The File menu contains tools for opening13

data sets, importing and exporting data in many14

different formats, and for changing and/or sav-15

ing various program settings and preferences.16

The Prepare menu contains a collection of17

tools that can be used at the beginning of a18

project to prepare a DEM for further analysis,19

such as mosaicking and sub-setting tiles, replac-20

ing bad values, uncompressing files and changing21

DEM attributes such as elevation units, byte or-22

der, orientation and data type. The Extract23

menu contains a large set of tools for extracting24

new grid layers (e.g. slope, curvature and con-25

tributing area), vectors (e.g. channels and basin26

boundaries) and masks (e.g. lakes and basins)27

from a DEM or a previously extracted grid layer.28

The Display menu has a collection of different29

visualisation tools such as density plots, contour30

plots, shaded relief, surface plots, river network31

maps, multi-layer plots and many more. Images32

can be displayed with any of 17 different map33

projections or without a map projection.34

There is also an extensive set of Interactive35

Window Tools that makes it easy to query and36

zoom into these images to extract additional in-37

formation. The Analyze menu has a number38

of tools for analysing and plotting terrain and39

watershed attributes that have been measured40

with the extraction tools. Graphics windows can41

be managed with a set of tools in the Window42

menu and RiverTools can be extended by users43

with plug-ins that appear in the User menu.44

18.2 Advanced GIS functionality 45

18.2.1 Fixed-angle and fixed-length grid 46

cells 47

Virtually all elevation data providers distribute 48

raster DEMs in one of two basic forms. In the ge- 49

ographic or fixed-angle form, the underlying grid 50

mesh is defined by lines of latitude and longitude 51

on the surface of a chosen ellipsoid model and 52

each grid cell spans a fixed angular distance such 53

as 3 arcsec. Lines of constant latitude (parallels) 54

and lines of constant longitude (meridians) al- 55

ways intersect at right angles. However, since 56

the meridians intersect at the poles, the distance 57

between two meridians depends on which paral- 58

lel that you measure along. This distance varies 59

with the cosine of the latitude and is largest at 60

the equator and zero at the poles. So while 61

each grid cell spans a fixed angle, its width is 62

a function of its latitude. The fixed-angle type 63

of DEM is the most common and is used for all 64

global or near-global elevation data sets such as 65

SRTM, USGS 1-Degree, NED, DTED, GLOBE, 66

ETOPO2, GTOPO30, MOLA and many others. 67

The second basic type of raster DEM is the 68

“fixed-length” form, where both the east-west 69

and north-south dimensions of each grid cell span 70

a fixed distance such as 30 metres. This type of 71

DEM is commonly used for high-resolution el- 72

evation data that spans a small geographic ex- 73

tent so that the Earth’s surface can be treated 74

as essentially planar. They are almost always 75

created using a Transverse Mercator projection 76

such as Universal Transverse Mercator (UTM). 77

Examples include USGS 7.5-Minute quad DEMs, 78

most LiDAR DEMs and many state and munic- 79

ipal DEMs. When mosaicked to cover large re- 80

gions, fixed-length DEMs suffer from distortion 81

and lead to inaccurate calculations of lengths, 82

slopes, curvatures and contributing areas. 83

18.2.2 Ellipsoids and projections 84

Unlike most GIS programs, RiverTools always 85

takes the latitude-dependence of grid cell dimen- 86

sions into account when computing any type of 87
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length, slope or area in a geographic or fixed-1

angle DEM. It does this by integrating directly2

on the ellipsoid model that was used to create the3

DEM. In addition, when measuring straight-line4

distance between any two points on an ellipsoid,5

the highly accurate Sodano algorithm is used6

(Sodano, 1965). Other GIS programs project7

the fixed-angle elevation data with a fixed-length8

map projection such as UTM and then compute9

all length, slope and area measurements in the10

projected and therefore distorted DEM.11

In RiverTools, various properties of the DEM12

such as its pixel geometry (fixed-angle or fixed-13

length), number of rows and columns and bound-14

ing box can be viewed (and edited if necessary)15

with the View DEM Info dialog in the File menu.16

When working with a fixed-angle DEM, the user17

should set the ellipsoid model to the one that18

was used in the creation of the original DEM19

data. This is done by opening the Set Prefer-20

ences dialog in the File menu and selecting the21

Planet Info panel. A list of 51 built-in ellipsoid22

models for Earth are provided in a droplist, as23

well as information for several other planets and24

moons. The ellipsoid models that were used to25

create several of the major DEM data sets is26

provided in the RiverTools documentation. Most27

modern DEM data sets and all GPS units now28

use the WGS84 ellipsoid model and this is the29

default. Since maps and images are necessarily30

two-dimensional, RiverTools also offers 17 differ-31

ent map projections for display purposes via the32

Map Projection Info dialog in the Display menu.33

18.3 Preparing DEMs for a study34

area35

18.3.1 Importing DEMs36

Since elevation and bathymetric data is dis-37

tributed in many different data formats, the first38

step when working with DEMs is to import the39

data, that is, to convert it to the format that is40

used by the analysis software. The DEM for-41

mats that can currently be imported include:42

ARC BIL, ARC FLT, ENVI Raster, Flat Binary,43

SDTS Raster Profile (USGS), USGS Standard44

ASCII, CDED, DTED Level 0, 1 or 2, GeoTIFF, 45

NOAA/NOS EEZ Bathymetry, GMT Raster 46

(netCDF), GRD98 Raster, ASTER, MOLA (for 47

Mars), SRTM, ARC Gridded ASCII, Gridded 48

ASCII, and Irregular XYZ ASCII. While some 49

DEMs simply store the elevations as numbers in 50

text (or ASCII) files, this is an extremely ineffi- 51

cient format, both in terms of the size of the data 52

files and the time required for any type of pro- 53

cessing. Because of this, elevation data providers 54

and commercial software developers usually use 55

a binary data format as their native format and 56

then provide a query tool such as the Value Zoom 57

tool in RiverTools for viewing DEM and grid val- 58

ues. 59

A simple, efficient and commonly used for- 60

mat consists of storing elevation values as binary 61

numbers with 2, 4 or 8 bytes devoted to each 62

number, depending on whether the DEM data 63

type is integer (2 bytes), long integer (4 bytes), 64

floating point (4 bytes) or double-precision (8 65

bytes). The numbers are written to the binary 66

file row by row, starting with the top (usually 67

northernmost) row — this is referred to as row 68

major format. The size of the binary file is then 69

simply the product of the number of columns, 70

the number of rows and the number of bytes 71

used per elevation value. All of the descriptive 72

or georeferencing information for the DEM, such 73

as the number of rows and columns, pixel di- 74

mensions, data type, byte order, bounding box 75

coordinates and so on is then stored in a sepa- 76

rate text file with the same filename prefix as the 77

binary data file and a standard three-letter ex- 78

tension. This basic format is used by ARC BIL, 79

ARC FLT, ENVI Raster, MOLA, SRTM, RTG 80

and many others. Many of the other common 81

formats, such as SDTS Raster, GeoTIFF and 82

netCDF also store the elevation data in binary, 83

row major format but add descriptive header in- 84

formation into the same file, either before or after 85

the data. 86

To import a DEM into RiverTools, you choose 87

Import DEM from the File menu and then se- 88

lect the format of the DEM you want to im- 89

port. If the format is one that is a special-case of 90

the RiverTools Grid (RTG) format (listed above), 91
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then the binary data file can be used directly and1

only a RiverTools Information (RTI) file needs to2

be created. You can import many DEMs that3

have the same format as a batch job by entering4

a “matching wildcard” (an asterisk) in both the5

input and output filename boxes. For example,6

to import all of the SRTM tiles in a given di-7

rectory or folder that start with “N30”, you can8

type “N30*.hgt” into both filename boxes.9

Elevation data is sometimes distributed as10

irregularly-spaced XYZ triples in a multi-column11

text file. RiverTools has an import tool for grid-12

ding this type of elevation data. In the cur-13

rent version, Delaunay triangulation is used but14

in the next release six additional gridding algo-15

rithms will be added.16

18.3.2 Mosaicking DEM Tiles17

The second step in preparing a DEM that spans18

a given area of interest is to mosaic many in-19

dividual tiles to create a seamless DEM for the20

area. These tiles are typically of uniform size21

and are distributed by DEM providers in sepa-22

rate files. For example, SRTM tiles span a re-23

gion on the Earth’s surface that is one degree of24

latitude by one degree of longitude and have di-25

mensions of either 1201Ö1201 (3 arc second grid26

cells) or 3601Ö3601 (1 arc second grid cells).27

To mosaic or subset DEM tiles in RiverTools,28

you first choose Patch RTG DEMs from the Pre-29

pare menu. This opens an Add/Remove dialog30

that makes it easy to add each of the tiles that31

you wish to mosaic to a list (Fig. 18.1a). Tiles32

can be viewed individually by clicking on the file-33

name for the tile and then on the Preview but-34

ton. Similarly, their georeferencing information35

can be viewed by clicking on the View Infofile36

button. Tiles with incompatible georeferencing37

information may sometimes need to be prepro-38

cessed in some way (e.g. units converted from39

feet to metres or subsampled to have the same40

grid cell size) and this can easily be done with41

the Convert Grid dialog in the Prepare menu.42

The file selection dialog that is used to add43

tiles to the list provides a filtering option for44

showing only the files with names that match45

a specified pattern. This dialog also allows mul- 46

tiple files to be selected at once by holding down 47

the shift key while selecting files. If these two fea- 48

tures are used, even large numbers of tiles can be 49

rapidly added to the list. The Add/Remove dia- 50

log itself has an Options menu with a Save List 51

entry that allows you to save the current list of 52

tiles to a text file. You can then later select the 53

Use Saved List option to instantly add the saved 54

list of files to the dialog. 55

Once you have finished adding DEM tiles to 56

the list, you can type a prefix into the dialog 57

for the DEM to be created and then click on 58

the Start button to display the DEM Patching 59

Preview Window (Fig. 18.1b). This shaded re- 60

lief image in this window shows how all of the 61

tiles fit together. You can then click and drag 62

within the image to select the subregion that is 63

of interest with a “rubber band box”, or select 64

the entire region spanned by the tiles by clicking 65

the right mouse button. It is usually best to se- 66

lect the smallest rectangular region that encloses 67

the river basin of interest. If you can’t discern 68

the basin boundary, you can easily iterate the 69

process a couple of times since everything is au- 70

tomated. The DEM Patching Preview window 71

has its own Options menu near the top and be- 72

gins with the entry Save New DEM. A button 73

with the same label is also available just below 74

the image. These are two different ways of doing 75

the same thing, namely to read data from each of 76

the DEM tiles to create a new DEM that spans 77

the selected region. If there are any “missing 78

tiles” that intersect the region of interest (per- 79

haps in the ocean) they are automatically filled 80

with nodata values. Other entries in the Options 81

menu allow you to do things like (1) label each 82

tile with its filename, (2) “burn in” the rubber 83

band box and labels and (3) save the preview 84

image in any of several common image formats. 85

Once your new DEM has been created, it is au- 86

tomatically selected just as if you had opened it 87

with the Open Data Set dialog in the File menu. 88

You can view its attributes using the View DEM 89

Info tool in the File menu. 90
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Fig. 18.1: (a) The Patch RTG DEM dialog; (b) The DEM Patching Preview window with subregion selected

with a rubber-band box and both tiles labeled with filename prefixes. (© Rivix, LLC, used with permission)

Fig. 18.2: A yellow box and crosshairs on a shaded relief image shows the location of a hole (red) in an

SRTM DEM for Volcan Baru, Panama. The two images on the right show wire mesh surface plots of

the area near the hole, before and after using the Repair Bad Values tool. (© Rivix, LLC, used with

permission)
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18.3.3 Replacing Bad Values1

Sometimes a third step is required to prepare a2

DEM that spans a region of interest. In SRTM3

tiles, for example, there are often nodata “holes”4

in high-relief areas that were not in the line of5

sight of the instrument aboard the Space Shut-6

tle that was used to measure the terrain heights.7

These holes usually span small areas between 18

and 20 grid cells but can be larger. For most9

types of analysis, these holes must be repaired10

prior to further processing. RiverTools has a Re-11

place Bad Values tool in the Prepare menu that12

fills these holes with reasonable values by itera-13

tively averaging from the edges of the holes until14

the hole is filled. The output filename should15

usually be changed to have a new prefix and16

the compound extension DEM.rtg. (Fig. 18.2)17

shows the result of applying this tool to an18

SRTM DEM for Volcan Baru, in Panama.19

18.4 Extracting land-surface20

parameters and objects from21

DEMs22

18.4.1 Extracting a D8 Flow Grid23

Once you have a DEM for an area of interest,24

there are a surprising number of additional grid25

layers, polygons, profiles and other objects that26

can be extracted with software tools and which27

are useful for various applications. Some of these28

were discussed in §7. Fig. 18.3 shows several29

land-surface parameters and objects that were30

extracted for the Baranja Hill case study DEM31

and which will be discussed throughout this sec-32

tion. A DEM with 5–meter grid cells was cre-33

ated from a source DEM with 25–meter grid cells34

via binlinear interpolation followed by smooth-35

ing with a 5Ö5 moving window, using the River-36

Tools Grid Calculator. This smoother DEM was37

used for creating the images shown except for38

Fig. 18.3(d).39

A D8 flow grid is perhaps the most fundamen-40

tal grid layer that can be derived from a DEM, as41

it is a necessary first step before extracting many42

other objects. RiverTools makes it easy to create43

a D8 flow grid and offers multiple options for 44

resolving the ambiguity of flow direction within 45

pits and flats. Choosing Flow Grid (D8) from 46

the Extract menu opens a dialog which shows 47

the available options. The default pit resolution 48

method is “Fill all depressions”. In most cases, 49

filling all depressions will produce a satisfactory 50

result since it handles the typically very large 51

number of nested, artificial depressions that oc- 52

cur in DEMs and even provides reasonable flow 53

paths through chains of lakes. However, support 54

for closed basins is also provided and is neces- 55

sary for cases where flow paths terminate in the 56

interior of a DEM, such as at sinkholes, land- 57

locked lakes or craters. The default flat resolu- 58

tion method is “Iterative linking”. As long as 59

the entire boundary of a river basin is contained 60

within the bounding box of the DEM, each of 61

the flat resolution methods will almost always 62

produce flow directions within flat areas of the 63

basin that send water in the right direction, de- 64

spite the absence of a local elevation gradient 65

(see the discussion of edge effects in §7). 66

Within broad, flat valleys, however, the “iter- 67

ative linking” method (Jenson, 1985, 1991) pro- 68

duces multiple streamlines that flow parallel to 69

one another until there is a bend in the axis of 70

the valley that causes them to merge. The main 71

problem with these parallel flow paths is that the 72

point at which one stream merges into another 73

(the confluence) is often displaced downstream 74

a considerable distance from where it should be. 75

The “Imposed gradients” option uses the method 76

published by Garbrecht and Martz (1997) to cre- 77

ate a cross-valley elevation gradient in flats and 78

tends to produce a single flow path near the cen- 79

ter of the valley. However, this method some- 80

times results in two parallel flow paths near the 81

center of valleys instead of one. The “Imposed 82

gradients plus” option was developed by Rivix 83

to merge any parallel flow path pairs (in flats) 84

into a single flow path. 85

Note: Increasing the vertical or horizontal 86

resolution of DEMs does not eliminate artificial 87

pits and flats and can even increase their num- 88

bers. 89
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Fig. 18.3: (a) Shaded relief image with labeled contour line overlay; (b) Shaded image of a D8 slope grid; (c)

Shaded image of a total contributing area grid, extracted using the mass flux method; (d) Drainage pattern

obtained by plotting all D8 flow vectors; (e) Watershed subunits with overlaid contours and channels (blue),

using a D8 area threshold of 0.025 km2; (f) Shaded image of plan curvature, extracted using the method

of Zevenbergen–Thorne. (© Rivix, LLC, used with permission)

18.4.2 Extracting and Saving a Basin1

Outlet2

Once you have created a D8 flow grid, there is an3

easy-to-use graphical tool in RiverTools for pre-4

cisely selecting which grid cell you want to use as5

a basin outlet. Choosing Basin Outlet from the6

Extract menu opens a dialog. Clicking on the7

dialog’s Start button produces an image (shaded8

relief or density plot) that shows the entire DEM.9

If you then click within the image window, a10

streamline from the place where you clicked to11

the edge of the DEM will be overplotted on the12

image. You can move the mouse and click again13

to select and plot another streamline. Some of14

the streamlines will flow into the main channel 15

of your basin of interest and some will flow into 16

other, disjoint basins. Once you have selected 17

a streamline that flows through the point you 18

wish to use as a basin outlet, you can then use 19

the slider in the dialog to move a red/white indi- 20

cator along the streamline to your desired basin 21

outlet point. 22

The precise grid cell coordinates are printed 23

in the Output Log window, and you can click 24

on the arrow buttons beside the slider to select 25

any grid cell along the streamline, even if the 26

image dimensions are many times smaller than 27

the DEM dimensions. This graphical tool is de- 28

signed so that you are sure to select a grid cell 29
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for the basin outlet that lies along any stream-1

line that you select, instead of a few pixels to one2

side or the other. Once you have selected a grid3

cell as a basin outlet with this two-step graphi-4

cal process, you simply click on the Save Outlet5

button in the dialog to save the coordinates in a6

text file with the extension “ basin.txt”.7

These coordinates identify the watershed that8

is of interest to you and are used by subsequent9

processing routines. Additional basic info for the10

basin will be appended to this file as you com-11

plete additional processing steps. By allowing12

any number of basin prefixes in addition to the13

data prefix associated with the DEM filename,14

RiverTools makes it easy to identify several wa-15

tersheds in a given DEM and extract information16

for each of them separately while allowing them17

to share the same D8 flow grid and other data18

layers. You can change the basin prefix at any19

time using the Change Basin Prefix dialog in the20

File menu. This tells RiverTools which watershed21

you want to work with.22

18.4.3 Extracting a River Network23

A river network can be viewed as a tree graph24

with its root at a particular grid cell, the out-25

let grid cell. The Extract 7→ RT Treefile dialog26

extracts the “drainage tree” for the watershed27

that drains to the outlet grid cell that you se-28

lected previously and saved. This is a raster to29

vector step that builds and saves the topology of30

the river network and also measures and saves a31

large number of attributes in a RiverTools vector32

(RTV) file with compound extension tree.rtv.33

The Extract 7→ River Network dialog can then be34

used to distinguish between flow vectors on hill-35

slopes and those that correspond to channels in a36

river network. The flow vectors on the hillslopes37

are pruned away and the remaining stream chan-38

nels are saved in another RTV file with extension39

links.rtv, along with numerous attributes. A40

variety of different pruning methods have been41

proposed in the literature and each has its own42

list of pros and cons. Fig. 18.4 shows a river43

network extracted from SRTM data for the Jing44

River in China.45

RiverTools supports pruning by D8 contribut- 46

ing area, by Horton-Strahler order, or by follow- 47

ing each streamline from its starting point on 48

a divide to the first inflection point (transition 49

from convex to concave). In addition, you can 50

use any grid, such as a grid created with the 51

Grid Calculator (via Extract 7→ Derived Grid) 52

together with any threshold value to define your 53

own pruning method. The real test of a prun- 54

ing method is whether the locations of channel 55

heads correspond to their actual locations in the 56

landscape, and this can only be verified by field 57

observations. Montgomery and Dietrich (1989, 58

1992) provide some guidance on this issue. See 59

Fig. 7.4 on page 141 for additional information 60

on pruning methods. 61

Fig. 18.4: Jing River in the Loess Plateau of China,

extracted from SRTM data with 3-arcsec grid cells.

Once you have completed the Extract 7→ RT 62

Treefile and Extract 7→ River Network process- 63

ing steps, you will find that your working di- 64

rectory now contains many additional files with 65

the same basin prefix and different filename 66

extensions. Each of these files contains in- 67

formation that is useful for subsequent analy- 68

sis. Three of these files end with the com- 69

pound extensions tree.rtv, links.rtv and 70

streams.rtv. These RTV files contain net- 71
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work topology as well as many measured at-1

tributes. For example, the attributes stored in2

the stream file for each Horton-Strahler stream3

are: upstream end pixel ID, downstream end4

pixel ID, Strahler order, drainage area, straight-5

line length, along-channel length, elevation drop,6

straight-line slope, along-channel slope, total7

length (of all channels upstream), Shreve mag-8

nitude, length of longest channel, relief, network9

diameter, absolute sinuosity, drainage density,10

source density, number of links per stream, and11

number of tributaries of various orders. RTV12

files and their attributes can also be exported as13

shapefiles with the Export Vector 7→ Channels14

dialog in the File menu.15

18.4.4 Extracting Grids16

D8-based Grids Once you have a D8 flow grid17

for a DEM, there are a large number of addi-18

tional grid layers that can be extracted within19

the D8 framework. RiverTools currently has 1420

different options in the Extract 7→ D8-based Grid21

menu. D8 area grids and slope grids are perhaps22

the best-known (see §7), but many other useful23

grid layers can be defined and computed, includ-24

ing grids of flow distance, relief, watershed sub-25

units and many others. Each of these derived26

grids inherits the same georeferencing informa-27

tion as the DEM.28

D-Infinity Grids As explained in §7, the29

D-Infinity algorithms introduced by Tarboton30

(1997) utilise a continuous flow or aspect angle31

and can capture the geometry of divergent flow32

by allowing “flow” to more than one of the eight33

neighbouring grid cells. These grids can be com-34

puted in RiverTools by selecting options from the35

Extract 7→ D-Infinity Grid menu.36

Mass Flux Grids As also explained in §7,37

the RiverTools Mass Flux algorithms provide an38

even better method for capturing the complex39

geometry of divergent and convergent flow and40

its effect on total contributing area (TCA) and41

specific contributing area (SCA). These grids42

can be computed in RiverTools by selecting op-43

tions from the Extract 7→ Mass Flux Grid menu.44

Fig. 18.5 and Fig. 18.3(c) show examples of con-45

tributing area grids computed via this method. 46

Fig. 18.6 shows continuous-angle flow vectors in 47

the vicinity of a channel junction or fork that 48

were extracted using the Mass Flux method and 49

then displayed with one of the interactive win- 50

dow tools. 51

Fig. 18.6: Continuous-angle flow vectors in the vicin-

ity of a channel junction or fork, extracted using the

Mass Flux method. (© Rivix, LLC, used with per-

mission)

Finite Difference Grids RiverTools can 52

compute many standard morphometric parame- 53

ters such as slope, aspect, first and second deriva- 54

tives, and five different types of curvature. It 55

currently does this using the well-known method 56

of Zevenbergen and Thorne (1987) that fits a 57

partial quartic surface to the (3Ö3) neighbour- 58

hood of each pixel in the input DEM and saves 59

the resulting grid as a RiverTools Grid (RTG) file. 60

Additional methods are planned for inclusion in 61

the next release. These grids can be computed 62

by selecting options from the Extract 7→ Finite 63

Difference Grid menu. 64

Other Derived Grids The Extract 7→ De- 65

rived Grids menu lists several other tools for cre- 66

ating grids. The most powerful of these is the 67

Grid Calculator that can create a new grid as 68

a function of up to three existing grids without 69

requiring the user to write a script. For exam- 70
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Fig. 18.5: A relief-shaded image of a TCA grid for Mt. Sopris, Colorado, that was created using the Mass

Flux method. Areas with a large TCA are shown in red while areas with a small TCA value (e.g. ridgelines)

are shown in blue and purple. Complex flow paths are clearly visible and results are superior to both the

D8 and D-infinity methods. (© Rivix, LLC, used with permission)

ple, it can be used to create any type of wet-1

ness index grid from grids of slope and specific2

area. The dialog resembles a standard scientific3

calculator. In addition to the operators shown,4

any IDL command that operates on 2D arrays5

(i.e. grids) can be typed into the function text6

box. The Restricted to RTM tool lets you create7

grids in which masked values are reassigned to8

have nodata values. For example, this tool can9

be used to create a new DEM in which every10

grid cell that lies outside of a given watershed’s11

boundary is assigned the nodata value.12

18.4.5 Extracting Masks or Regions of13

Interest14

Within grid layers one often wishes to restrict15

attention or analysis to particular regions of in-16

terest or polygons, such as watersheds, lakes,17

craters, or places with elevation greater than18

some value. In order to display or perform any19

kind of analysis for such a region, we need to20

know which grid cells are in the region and which21

are not. This is equivalent to knowing the spa-22

tial coordinates of its boundary. A large number 23

of different attributes can be associated with any 24

such polygon, such as its area, perimeter, diam- 25

eter (maximum distance between any two points 26

on the boundary), average elevation, maximum 27

flow distance or centroid coordinates. RiverTools 28

Mask (RTM) files provide a simple and compact 29

way to store one or more masked regions in a file. 30

A complete description of RTM files is given in 31

an appendix to the User’s Guide. 32

There are a number of different tools in the 33

Extract 7→ Mask submenu that can be used to 34

create RTM files. For example, watershed poly- 35

gons of various kinds can be extracted with the 36

Sub-basin Mask tool, lake polygons can be ex- 37

tracted with the Connected-to-Seed Mask tool, 38

and threshold polygons can be extracted with 39

the Grid Threshold Mask tool. Creative use of 40

these tools can solve a large number of GIS-query 41

problems. RTM files that record the locations of 42

single or multi-pixel pits are created automati- 43

cally by the Extract 7→ Flow Grid (D8) tool. A 44

tesselation of watershed subunits can be created 45

with the Extract 7→ D8-based Grid 7→Watershed 46
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Subunits tool. RTM files can also be merged by1

the Merge Files tool in the Prepare menu. Given2

an RTM file for a region of interest, the Export3

Vector 7→ Boundaries tool in the File menu can4

create an ESRI shapefile for the polygon and5

can also compute and save 36 optional attributes6

(new in the next release).7

18.4.6 Extracting Functions8

Hypsometric curves or area-altitude func-9

tions have a long history (Strahler, 1952; Pike10

and Wilson, 1971; Howard, 1990) and River-11

Tools can extract this and several other func-12

tions from a DEM (Fig. 18.7). The width func-13

tion (Kirkby, 1976; Gupta et al., 1980; Trout-14

man and Karlinger, 1984) and closely related15

area-distance function measure the fraction16

of a watershed (as number of links or percent17

area) that is at any given flow distance from18

the outlet (Extract 7→ Function menu) and are19

tied to the instantaneous unit hydrograph con-20

cept. The cumulative area function (Rigon21

et al., 1993; Peckham, 1995b) measures the frac-22

tion of a watershed that has a contributing area23

greater than any given value (Extract 7→ Chan-24

nel Links 7→ Link CDF ). Empirical cumula-25

tive distribution functions (ECDFs) (Peck-26

ham, 1995b; Peckham and Gupta, 1999) for en-27

sembles of basins of different Strahler orders have28

been shown to exhibit statistical self-similarity:29

Analyze 7→ Strahler streams 7→ Stream CDFs.30

It has been suggested by Willgoose et al. (2003)31

that some of these functions can be used together32

to measure the correspondence between real and33

simulated landscapes.34

18.5 Visualisation tools35

RiverTools has a rich set of visualisation tools,36

many of which are centrally located in the Dis-37

play menu. Each tool provides numerous op-38

tions which are explained in context-specific help39

pages, available by clicking on the Help button at40

the bottom of the dialog. After changing the set-41

tings in the dialog, you click on the Start button42

to create the image. There are too many display43

tools and options to describe each one in detail 44

here, so the purpose of this section is to provide a 45

high-level overview. Many of the tools have their 46

own colour controls, but colour schemes can also 47

be set globally with the Set Colors dialog and 48

saved with the Set Preferences dialog. Both of 49

these are launched from the File menu. Most of 50

the images created by tools in the Display menu 51

can be shown with a map projection, and the 52

projection can be configured with the Map Pro- 53

jection Info dialog at the bottom of the menu. 54

Menus labelled Options, Tools and Info at the 55

top of image windows provide additional func- 56

tionality, such as the ability to print an image or 57

save it in any of several popular image formats. 58

The Tools menu contains a large number of In- 59

teractive Window Tools that will be highlighted 60

in the next section. 61

The Density Plot tool creates colour-by- 62

number plots, and offers many different types of 63

contrast-enhancing ‘stretches’ including linear, 64

logarithmic, power-law and histogram equalisa- 65

tion. For example, contributing area grids are 66

best viewed with a power-law stretch, due to 67

the fact that there are a small number of grid 68

cells with very large values and a large number 69

with very small values. The Contour Plot tool 70

makes it easy to create either standard or filled 71

contour plots (or both as a multi-layer plot) and 72

provides a large number of options such as the 73

ability to control the line style, width and colour 74

of each contour line. Colour shaded relief images 75

with different colour tables and lighting condi- 76

tions can easily be created with the Shaded Re- 77

lief tool (Fig. 18.8). There is also a tool called 78

Shaded Aspect that simply uses D8 flow direc- 79

tion values with special colour tables to visualise 80

DEM texture. A Masked Region tool allows 81

you to display the boundaries or interiors of one 82

or more “mask cells” or polygons (e.g. basins, 83

pits, lakes, etc.) which are stored in RTM (River- 84

Tools Mask) files with the extension .rtm. A re- 85

lated tool is the ESRI Shapefile tool which has 86

numerous options for plotting vector data that 87

is stored in a shapefile, including points, poly- 88

lines and polygons. (Shapefiles may be created 89

from RTV and RTM files with the Export Vector 90
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7→ Channels and Export Vector 7→ Boundaries1

tools in the File menu.) A button labeled View2

Attr. Table at the bottom of this dialog displays3

a shapefile’s attribute table, and the table can4

be sorted by clicking on column headings. Digi-5

tal Line Graph (DLG) data in the now-standard6

SDTS format can be displayed by itself or as a7

vector overlay with the DLG–SDTS tool.8

The Function tool in the Display menu reads9

data from a multi-column text file and creates a10

plot of any two columns. There are several places11

in RiverTools where data can be saved to a multi-12

column text file (e.g. longitudinal profiles) and13

later displayed with this tool. Perspective-view14

plots for an entire DEM can be displayed with15

the Surface Plot tool as wire-mesh, lego-style16

or shaded. For larger DEMs, however, better re-17

sults are obtained with the Surface Zoom window18

tool which is explained in the next section. Ex-19

tracted river networks, which are saved in RTV20

(RiverTools Vector) files can be displayed with21

the River Network tool, or first exported via22

File 7→ Export Vector 7→ Channels and displayed23

with the ESRI Shapefile tool. Using the Multi-24

Layer Plot tool, images created by many of the25

tools in the Display menu can be overlaid, that26

is, any number of vector plots can be overlaid on27

any raster image.28

One of the most powerful tools in the Display29

menu is the Grid Sequence tool. This tool30

is for use with RTS (RiverTools Sequence) files,31

which are a simple extension1 of the RTG (River-32

Tools Grid) format. RTS files contain a grid33

sequence, or grid stack, usually with the same34

georeferencing as the DEM. Grids in the stack35

are usually indexed by time and are typically36

created with a spatially-distributed model that37

computes how values in every grid cell change38

over time. For example, a distributed hydrologic39

model called TopoFlow2 can be used as a plug-in40

to RiverTools (see §25). TopoFlow computes the41

time evolution of dynamic quantities (e.g. water42

depth, velocity, discharge, etc.) and can save the43

resulting sequence of grids as an RTS file. Land-44

1All of the RiverTools formats are nonproprietary and
are explained in detail in an appendix to the user’s guide.

2http://instaar.colorado.edu/topoflow/

scape evolution models also generate grid stacks 45

that show how elevations change over time. This 46

tool can show a grid stack as an animation or 47

save it in the AVI movie format. It allows you 48

to jump to a particular frame, change colours 49

and much more. The Options menu at the top 50

of the dialog has many additional options and 51

there is also a Tools menu that has tools for in- 52

teractively exploring grid stack data, such as the 53

Time Profile and Animated Profile tools. 54

18.5.1 Interactive Window Tools 55

As mentioned previously, image windows that 56

are created with the tools in the Display menu 57

typically have three menus near the top of the 58

window labelled Options, Tools and Info. In 59

RiverTools, the entries in an Options menu rep- 60

resent simple things that you can do to the win- 61

dow, such as resize it, print it, close it or save 62

the image to a file. The entries in a Tools menu 63

represent ways that you can use the mouse and 64

cursor to interact with or query the image. Here 65

again we will simply give a high-level overview 66

of several of these tools, but more information is 67

provided in the user’s guide. 68

Fig. 18.9: Longitudinal profile plot created for a

main channel of the Beaver Creek DEM with the

Channel Profile tool.

The Line Profile tool lets you click and drag 69

in an image to draw a transect and then opens 70

another small window to display the elevation 71

values along that transect. Note that this new 72

window has its own Options menu that lets you 73
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Fig. 18.7: Functions extracted from a DEM for Beaver Creek, Kentucky: (a) an area-altitude plot and (b)

an area-distance plot.

Fig. 18.8: High-resolution MOLA (Mars Orbiter Laser Altimeter) DEM displayed in RiverTools: colour

shaded relief image for planet Mars shown by the cylindrical equidistant map projection.
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do things like save the actual profile data to a1

multi-column text file. The Channel Profile2

tool is similar (Fig. 18.9), except that you click3

somewhere in the image and then the flow path4

or streamline from the place where you clicked5

to the edge of the DEM is overlaid on the image.6

The elevations (or optionally, the values in any7

other grid) along that streamline are plotted vs.8

distance along the streamline in another small9

window. Again, the Options menu of this new10

window has numerous entries.11

The Reach Info tool is similar to the Chan-12

nel Profile tool but opens an additional dialog13

with sliders that let you graphically select the up-14

stream and downstream endpoints of any reach15

contained within the streamline and displays var-16

ious attributes of that reach. If you select Vec-17

tor Zoom from the Tools menu and then click18

in the image, crosshairs are overlaid on the im-19

age and a small window is displayed that shows20

grid cell boundaries, D8 flow paths and contour21

lines in the vicinity of where you clicked.22

Fig. 18.10: The Value Zoom dialog.

The Value Zoom tool is similar but displays23

actual grid values as numbers and also shows the24

coordinates of the selected grid cell (Fig. 18.10).25

This tool has many other capabilities listed in its26

Options menu, such as the ability to edit grids or27

jump to specified coordinates. Perspective, wire28

mesh plots are more effective when applied to29

smaller regions rather than to entire DEMs, so30

the Surface Zoom tool provides a powerful way31

to interactively explore a landscape (Fig. 18.11).32

This tool has many settings at the bottom of the33

display window and many entries in its Options34

menu. The Density Zoom and Relief Zoom 35

tools show density plots (see last section) and 36

shaded relief plots at full resolution for a selected 37

region even though the main image may show the 38

entire area of the DEM at a greatly reduced res- 39

olution. All of the Zoom-tools are automatically 40

linked, so that they all update when you move 41

the mouse to another location in the image. The 42

Add Scale Bar, Add Colour Bar, Add Text 43

and Add Marker tools can be used to interac- 44

tively annotate an image prior to saving it to an 45

image file with Options 7→ Save Window. 46

Finally, the Flood Image tool allows you to 47

change the colour of all pixels below a given el- 48

evation to blue, either instantly or as an anima- 49

tion. It is a useful visualisation tool but does not 50

model the dynamics of an actual flood. 51

Fig. 18.11: The Surface Zoom display window.

18.6 Summary Points 52

RiverTools is a powerful but easy-to-use toolkit 53

for visualising and extracting information from 54

digital elevation data. It has an intuitive, 55

point-and-click graphical interface, an extensive 56

HTML-based help system and much of the power 57

of a full-featured GIS even though its main fo- 58

cus is on digital elevation data. It also contains 59

state-of-the-art algorithms for computing geo- 60
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morphometric quantities, such as the new Mass1

Flux method for computing contributing area.2

This unique combination of features makes it3

ideal for teaching courses in hydrology, landscape4

ecology and geomorphology. RiverTools can im-5

port a wide variety of DEM formats as well as6

vector data in the ESRI shapefile and DLG-7

SDTS formats. It works well together with other8

GIS software since it can also export raster data9

in several common formats (via File 7→ Export10

Grid) and vector data in the industry-standard11

shapefile format (via File 7→ Export Vector).12

Publication-quality graphics and posters are eas-13

ily created and annotated. Many built-in fea-14

tures including a graphical Grid Calculator and15

support for wildcards in many places where an16

input filename is required (to allow batch pro-17

cessing) mean that writing scripts is usually not18

necessary. However, in cases where scripting is19

required, users have the option to purchase an-20

other product called IDL (Interactive Data Lan-21

guage, a product of ITT Visual Information So-22

lutions, www.ittvis.com) that can be used to23

write extensions to RiverTools. This option pro-24

vides access to all of the features of the IDL pro-25

gramming language in addition to a large set of26

documented, low-level RiverTools commands for27

customisation. Users can also extend RiverTools28

with free User menu plug-ins, such as a landscape29

evolution model called Erode and a spatially-30

distributed hydrologic model called TopoFlow.31

RiverTools has been developed and refined over32

many years around three central themes, namely33

(1) ease of use, (2) ability to handle very large34

DEMs (whatever the task) and (3) accuracy of35

measurements. With regard to ease of use, Rivix36

has worked with users for many years to develop37

a user-friendly graphical interface and HTML38

help system. As for the ability to rapidly ex-39

tract information from very large DEMs, this40

has driven the development of advanced algo-41

rithms that efficiently distribute the computa-42

tional workload between available RAM and I/O43

to files. These types of algorithms are used44

throughout RiverTools. Finally, RiverTools and45

MicroDEM may be the only GIS applications46

that always take the latitude-dependence of pixel47

geometry into account when working with geo- 48

graphic DEMs. All lengths, slopes and areas are 49

computed by integrating on the surface of the 50

appropriate ellipsoid model to avoid the geomet- 51

ric distortion that is associated with map projec- 52

tions. This feature is especially important when 53

working with DEMs at the regional, continental 54

or global scale. 55

Important sources: 56

57

F Rivix LLC, 2004. RiverTools 3.0 User’s 58

Guide. Rivix Limited Liability Company, 59

Broomfield, CO, 218 pp. 60

F http://rivertools.com — RiverTools 61

website. 62

F http://instaar.colorado.edu/topoflow/ 63

— TopoFlow Website. 64

F http://www.ittvis.com — ITT Visual In- 65

formation Solutions. 66


